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Preface

About This Manual

This manual provides detailed instructions for installing the Rational ClearCase family of
products and upgrading ClearCase LT to ClearCase.

This ClearCase release includes the ClearCase, MultiSite, and Attache helper products. Where

the term “CPF products” appears in this manual, it denotes the set of ClearCase products
included in a particular release.

Preface vii
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Preface

Typographical Conventions

This manual uses the following typographical conventions:

O

ccase-home-dir represents the directory into which the ClearCase Product Family has been
installed. By default, this directory is /usr/atria on UNIX and
C:\Program Files\Rational\ClearCase on Windows.

attache-home-dir represents the directory into which ClearCase Attache has been installed.
By default, this directory is C:\Program Files\Rational\ Attache, except on Windows 3.x,
where it is C:\RATIONAL\ATTACHE.

Bold is used for names the user can enter; for example, all command names, file names, and
branch names.

Italic is used for variables, document titles, glossary terms, and emphasis.

A monospaced font  is used for examples. Where user input needs to be distinguished
from program output, bold is used for user input.

Nonprinting characters are in small caps and appear as follows: <EOF>, <NL>.
Key names and key combinations are capitalized and appear as follows: SHIFT, CTRL+G.
[1 Brackets enclose optional items in format and syntax descriptions.

{}  Braces enclose a list from which you must choose an item in format and syntax
descriptions.

I A vertical bar separates items in a list of choices.

In a syntax description, an ellipsis indicates you can repeat the preceding item or line
one or more times. Otherwise, it can indicate omitted information.

NOTE: In certain contexts, ClearCase recognizes “...” within a pathname as a wildcard, similar
to “*” or “?”. See the wildcards_ccase reference page for more information.

If a command or option name has a short form, a “medial dot” ( O) character indicates the
shortest legal abbreviation. For example:

1sc-heckout

This means that you can truncate the command name to Isc or any of its intermediate
spellings (Isch, 1sche, Ischec, and so on).



Online Documentation
The ClearCase graphical interface includes a standard Windows help system.

There are three basic ways to access the online help system: the Help menu, the Help button, or
the F1 key. Help>Help Topics provides access to the complete set of ClearCase online
documentation. For help on a particular context, press F1. Use the Help button on various dialog
boxes to get information specific to that dialog box.

ClearCase also provides access to full “reference pages” (detailed descriptions of ClearCase
commands, utilities, and data structures) with the cleartool man subcommand. Without any
argument, cleartool man displays the cleartool overview reference page. Specifying a command
name as an argument gives information about using the specified command. For example:

> cleartool man (display the cleartool overview page)
> cleartool man man (display the cleartool man reference page)
> cleartool man checkout (display the cleartool checkout reference page)

ClearCase’s —help command option or help command displays individual subcommand syntax.
Without any argument, cleartool help displays the syntax for all cleartool commands. help
checkout and checkout —help are equivalent.

> cleartool uncheckout —help
Usage: uncheckout | unco [-keep | -rm] [-cact | -cwork ] pname ...

Additionally, the online ClearCase Tutorial provides important information on setting up a user’s

environment, along with a step-by-step tour through ClearCase’s most important features. To
start the ClearCase Tutorial, choose Tutorial in the ClearCase folder off the Start menu.

ClearCase Product Family Installation Notes



Preface

Technical Support

If you have any problems with the software or documentation, please contact Rational Technical
Support via telephone, fax, or electronic mail as described below. For information regarding

support hours, languages spoken, or other support information, click the Technical Support link
on the Rational Web site at www.rational.com.

Your Location

Telephone

Facsimile

Electronic Mail

North America

800-433-5444
toll free or
408-863-4000
Cupertino, CA

408-863-4194
Cupertino, CA
781-676-2460
Lexington, MA

support@rational.com

Europe, Middle
East, and Africa

+31-(0)20-4546-200
Netherlands

+31-(0)20-4546-201
Netherlands

support@europe.rational.com

Asia Pacific

61-2-9419-0111
Australia

61-2-9419-0123
Australia

support@apac.rational.com

Xi
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Overview and Installation-Related
Operations

This document describes how to install the Rational ClearCase family of products on Windows
computers and upgrade ClearCase LT to ClearCase.

This chapter provides pointers to the installation instructions for the type of installation that you
want to perform. It also describes the installation-related operations of patch installation and
removing ClearCase.

1.1 ClearCase Installation Overview

Type of installation Location of instructions
Upgrading an existing ClearCase release Chapter 2

Upgrading ClearCase LT to ClearCase Chapter 3

Installing ClearCase for the first time Chapter 4

Installing ClearCase for an evaluation Chapter 5

Installing ClearCase patches Section 1.3

Removing ClearCase Section 1.4

Allocating licenses Appendix A

Before you start, read ClearCase Installation Directory Conventions on page 2.

1 - Overview and Installation-Related Operations 1



1.2

ClearCase Installation Directory Conventions

ClearCase documentation uses ccase-home-dir as shorthand for the ClearCase installation
directory. When you encounter this notation, substitute your own local ClearCase installation
directory for ccase-home-dir.

For new installations, the default installation directory is

system_drive:\Program Files\Rational\ClearCase, where systern_drive is the drive that contains
Windows system files. A typical installation directory is

C:\Program Files\Rational\ClearCase.

For an existing installation of ClearCase, the default installation directory is the one in which the
previous version is installed.

NOTE: A ClearCase administrator can change the site-wide default for the installation directory
by running the Site Preparation Wizard (see Running the ClearCase Site Preparation Wizard on
page 32).

1.3

Installing ClearCase Patches

The Rational Web site provides information about patches; see http://clearcase.rational.com and
click Patches on the site menu. Note that this site is password protected; to authenticate, you
need your host ID (for the user name) and license string (for the password).

At the beginning of the patch installation program, you can choose to patch a network release
area or an individual host.

0 If you want to patch a network release area, enter the release area installation directory in
the text box.

0 If you want to patch an individual host, click Only patch this system, not the release area.

We recommend that you patch a release area because doing so allows you to construct a single
install version of ClearCase with all the patches needed for your site. After the patch is applied
to the release area, users must run (or rerun) the ClearCase Installation Wizard from the release
area to get the latest patch.

ClearCase Product Family Installation Notes



1.4 Removing a ClearCase Installation

CAUTION: If Rational Shipping Server is installed on the computer from which you are removing
ClearCase, uninstalling ClearCase removes components necessary to run the Shipping Server.
You need to reinstall the Shipping Server if you want to continue using it. For information on
installing the Shipping Server, see the manual Installing Rational ClearQuest.

If you installed ClearCase from the release area, the computer from which you are removing
ClearCase must have access to the networkwide release area. Follow this procedure to remove
ClearCase:

In Windows NT, Windows 98 and Windows Me:

1. In Control Panel, run Add/Remove Programs.

2. On the Install/Uninstall tab, select ClearCase from the list.

3. Click Add/Remove.

In Windows 2000:

1. In Control Panel, run Add/Remove Programs.

2. On the Change or Remove Programs tab, select ClearCase from the list.

3. Click Change/Remove.

If you have installed ClearCase from CD, you must remove it by running the following program
from the CD:

cd_drive:\cpf\nt_i386 \uninstal.exe

1 - Overview and Installation-Related Operations 3
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Upgrading an Existing ClearCase
Release

This chapter describes how to install a new release of the ClearCase family of products on a
Windows computer where Rational ClearCase is already installed.

This chapter assumes that you are a ClearCase administrator who is familiar with the
site-preparation and installation procedures. Detailed information about these procedures is in
Chapter 4, Installing ClearCase for Windows for the First Time.

2.1 Requirements for Upgrading to a New ClearCase Release

For information about the requirements for upgrading to this release of ClearCase, see README
First in the ClearCase and MultiSite Release Notes.

2.2 ClearCase Installation Directory Conventions
ClearCase documentation uses ccase-home-dir as shorthand for the ClearCase installation
directory. When you encounter this notation, substitute your own local ClearCase installation

directory for ccase-home-dir.

For an existing installation of ClearCase, the default installation directory is the one in which the
previous version is installed.

2 - Upgrading an Existing ClearCase Release 5



NOTE: A ClearCase administrator can change the site-wide default for the installation directory
by running the Site Preparation Wizard. (See Running the ClearCase Site Preparation Wizard on
page 32.)

2.3

Preinstallation Notes

Make sure that you have local administrator privileges. If you are installing a client with local
VOBs and views, you must also have the password for the ClearCase service account to run the
ClearCase Site Preparation Wizard.

If a Windows NT computer contains view-storage or VOB-storage directories, upgrading to a
ClearCase client installation that does not support local views and VOBs disables any views and
VOBs whose storage directory is located on that computer. This applies to all dynamic views and
snapshot views created with the defaults suggested by the View Creation Wizard or cleartool mkview.

This situation occurs because upgrading to that kind of client installation removes the software
necessary to run view or VOB server processes. (The view-server and VOB-server processes

typically run on the computer on which the storage directory is located.)

For details, see README FIRST in the ClearCase and MultiSite Release Notes.

VOB Database Support

ClearCase supports two VOB database formats: the older format (schema version 53) and the
newer format (schema version 54). The ClearCase release 3.x family only supports the older VOB
format (schema version 53); ClearCase releases 4.0 and later support both the older and newer
formats.

Schema version 54 provides the following new features:
0 Files in the VOB database can grow beyond 2 GB.
Typically, ClearCase sites do not need databases this large.
O Better support for storing native Windows NT identity information.

This feature is valuable in environments with multiple Windows NT domains.

ClearCase Product Family Installation Notes



ClearCase release VOB formats supported

3.x family Schema version 53

4.0 and later Schema version 53 and 54

As part of installing this ClearCase release on a server, you must select which VOB format you
want to use:

0 If you are an existing ClearCase customer, you probably want to select the format that you
are currently using.

0 If you are an existing customer using schema version 53 and you select schema version 54,
you will have to reformat your existing VOBs immediately after rebooting to allow users to
access VOB data.

0 If you are a new ClearCase customer, you probably want to select the latest VOB format
(schema version 54).

If a server host contains replicated VOBs using ClearCase MultiSite, we recommend that all VOB
servers of the same set of replicas use the same VOB format.

If you have an existing ClearCase installation that uses schema version 53 and you select the
same VOB format for this installation but then change your mind, you can reinstall ClearCase,
select schema version 54, and then reformat your VOBs.

If you have an existing installation that uses schema version 53 and you select schema version 54
for this installation but change your mind before having reformatted your VOBs, you can
reinstall ClearCase and select schema version 53. However, if you have already reformatted your
VOBs, Rational does not support reformatting back to the older VOB format.

See the reformatvob reference page for more information about VOB database formats, the
implications of each selection, and what you need to know to reformat your VOBs.

2 - Upgrading an Existing ClearCase Release 7



2.4

Running the ClearCase Site Preparation Wizard

Because you are upgrading from a previous ClearCase release, you can skip the planning and
configuration steps for first-time installations (Chapter 4). You need only run the ClearCase Site
Preparation Wizard from the CD on a computer that already has ClearCase installed.

The Site Preparation Wizard helps you create a new release area for this ClearCase release. You
must create a new release area because the files in the previous release area are read-only. To help
you create a new release area, the wizard appends the version of the release onto the release area
name. For example, ClearCase 4.2 is netinst_4.2 to differentiate it from a previous release area.
In addition, the application checks for the existence of a read-only sitedefs.dat file. For more
information about what happens when you overwrite other read-only files, see Overwriting
Existing Network Release Areq.

The license server, registry server, credentials server, mail server, and registry regions are set to
values from the local computer on which you run the Site Preparation Wizard. If no values were
previously set, the field is blank and you must supply host or region settings. For more
information, see Administering ClearCase.

More information about release areas is provided in Chapter 4 for first-time installations,
specifically the sections Running the ClearCase Site Preparation Wizard on page 32 and Creating
Multiple Release Areas on page 35.

Overwriting Existing Network Release Area

When a ClearCase administrator reruns the Site Preparation Wizard from the CD and attempts
to overwrite an existing network release area, the wizard fails while copying the installation files
and generates the following error:

Error copying file “<filename>"
Access is denied.

This error occurs because the files in a network release area are set to read-only to prevent
inadvertent damage to the files. For this reason, you must use separate network release areas for
each ClearCase release. In any case, it is often useful to preserve the previous release for historical
reasons.
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2.5 Running the ClearCase Installation Wizard
After running the Site Preparation Wizard, run the Installation Wizard to install ClearCase on
this computer. Chapter 4 provides more information for initial installations, specifically Running

the ClearCase Installation Wizard on page 35.

After you create and configure a release area, individual users can install ClearCase on their
computers.

NOTE: Servers should be upgraded before any clients are upgraded.

2.6 Completing the Installation

ClearCase Doctor runs automatically after the installation. Examine its results and perform the
postinstallation steps, as you do for an initial installation. For more information, see Examining
ClearCase Doctor Results on page 37 and Completing the Installation on page 38.

2.7 Completing the Installation on VOB Server Hosts

If you are upgrading your VOB server hosts from a previous ClearCase release and the feature
level of the releases differ, you must raise the feature level of your existing VOBs. This has to be
done regardless of the VOB database format you have selected. If you don’t raise the VOB’s
feature level, some 4.x functionality including UCM will be unavailable, even if you have
selected the newer VOB format.

To determine the feature level of both the new release and the release from which you upgraded,
see the ClearCase and MultiSite Release Notes.

O If the feature levels are the same, there are no additional steps to take.

O If the feature levels differ, see Administering ClearCase and the chflevel reference page for
instructions on raising the feature level of unreplicated VOBs. See the ClearCase MultiSite
Manual for instructions on raising the feature level of replicated VOBs.

2 - Upgrading an Existing ClearCase Release 9
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Upgrading ClearCase LT to
ClearCase

Rational ClearCase LT can be easily upgraded to full-featured Rational ClearCase. ClearCase
includes a tool that helps automate the upgrade process, though a few manual steps may be
required to upgrade certain configurations. This chapter explains the upgrade process and
describes two common upgrade scenarios.

3.1

What Happens When You Upgrade?

When you upgrade from ClearCase LT to ClearCase, you add many new capabilities to your
existing ClearCase LT environment without having to sacrifice any of your ClearCase LT data,
change the way you use UCM or any other software development process, or incur extensive
project downtime. The upgrade preserves all of your ClearCase LT VOB data, including UCM
project data, event history, metadata, and customizations such as triggers and type managers.
VOBs do not need to be reformatted. Your upgraded ClearCase LT server and client hosts will
not need to be reconfigured in any way.

ClearCase supports a number of powerful features not available in ClearCase LT:

The ability for a client to access multiple servers

Dynamic views, which use the ClearCase multiversion file system (MVES)
ClearCase build auditing tools

An expanded ClearCase registry that supports registry regions

Compeatibility with Rational ClearCase MultiSite, which you can purchase to provide
support for geographically dispersed development teams

O0oooag
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You can read about these and other ClearCase features in Introduction to ClearCase and Managing
Software Projects with ClearCase, as well as in Administering ClearCase, which also describes several
procedures you may need to follow when you upgrade. These documents are available in
hardcopy and as part of the ClearCase online document set. Click

Start>Programs>Rational ClearCase>ClearCase Help. On the Contents tab, click

Online Manuals. These documents are also available in HTML form on the ClearCase customer
Web site clearcase.rational.com.

Any upgrade from ClearCase LT to ClearCase requires these basic steps:
1. Acquire ClearCase licenses for users of the upgraded ClearCase LT hosts.
2. Check in any checked-out files or directories.

3. Remove all views. (This step may not be necessary if your ClearCase LT server is running
UNIX.)

4. Remove ClearCase LT software from the ClearCase LT server host.

5. Install ClearCase on the ClearCase LT server host in the same directory that had previously
been used for ClearCase LT on this host.

6. Run the ClearCase LT upgrade tool cclt2cc on the upgraded ClearCase LT server host.
7. Install ClearCase on the ClearCase LT client hosts.

8. Create new snapshot and/or dynamic views.
Additional steps may be needed, depending on the upgrade scenario you choose.

NOTE: If you are upgrading a ClearCase LT community whose ClearCase LT server is running
Windows NT and you need to access VOBs on the upgraded server from dynamic views on
ClearCase hosts running UNIX, you must move the VOBs to a ClearCase VOB server host
running UNIX. ClearCase hosts running UNIX cannot use dynamic views to access VOBs hosted
on Windows NT. Contact Rational Support for information on moving a VOB from Windows NT
to UNIX.

3.2

Upgrade Scenarios

This chapter describes two upgrade scenarios:

ClearCase Product Family Installation Notes



0 Simple Upgrade: In this scenario, you upgrade a single ClearCase LT community (one
server and some or all of its clients) to ClearCase. The ClearCase LT server becomes a
ClearCase server and continues to host all the VOBs it hosted as a ClearCase LT server. It
also becomes the ClearCase registry host and license server host. The ClearCase LT clients
become ClearCase clients.

You can upgrade your ClearCase LT server and its clients in a single operation or upgrade
the server first and upgrade the clients later. A ClearCase LT client can access an upgraded
ClearCase LT server as long as it can acquire a ClearCase license from that server; but the
client cannot take advantage of ClearCase features until it has been upgraded.

0 Upgrade and merge: In this scenario, you upgrade ClearCase LT server and all of its clients
to ClearCase, and then incorporate the ClearCase LT VOBs and upgraded hosts into an
existing ClearCase installation. The VOBs can remain on the upgraded ClearCase LT server
or can be moved to another ClearCase VOB server.

3.3 Preparing to Upgrade

Before you upgrade, you may need to take one or more of the following steps to ensure that the
upgrade goes smoothly:

O Acquire ClearCase licenses for ClearCase LT users who are being upgraded. Acquire
ClearCase MultiSite licenses for users of the upgraded ClearCase LT hosts who need access
to replicated VOBs. Your existing ClearCase LT licenses will not work with ClearCase.

0 If this is a simple upgrade, designate an appropriate host for the ClearCase networkwide
release area. (The upgrade and merge scenario uses an existing release area.)

0 Check in all checked-out files and directories. ClearCase LT views cannot be upgraded for
use by ClearCase hosts. After the upgrade is complete, you can create new snapshot or
dynamic views as needed.

0 If upgraded users will need to access VOBs on UNIX hosts from dynamic views on
Windows NT, you must acquire and configure an appropriate third-party software package
to enable cross-platform file-system access.

3 - Upgrading ClearCase LT to ClearCase 13
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Acquire ClearCase Licenses

ClearCase requires its own licenses and its own license server. ClearCase MultiSite requires an
additional set of licenses, one for each user who will need access to a replicated VOB.

To ensure uninterrupted operation, obtain your ClearCase licenses and, if necessary, MultiSite
licenses from Rational before you begin the upgrade process. Licensing forms and instructions
for using them are included at the end of this document.

NOTE: ClearCase and ClearCase LT use different procedures for requesting and installing
licenses. The Rational License Key Administrator and Rational AccountLink Web site cannot be
used to acquire ClearCase licenses.

Select ClearCase License Server and Registry Server Hosts

ClearCase requires a license server host and a registry server host. These may be separate
computers or the same computer. After a simple upgrade, the upgraded ClearCase LT server
performs both functions. After an upgrade and merge, existing ClearCase license and registry
server hosts perform these functions.

If you are performing a simple upgrade and designate your ClearCase LT server as the ClearCase
license server and registry server host, all ClearCase LT clients, whether or not they have been
upgraded, can access VOBs and views on the upgraded ClearCase LT server with a minimum of
reconfiguration.

If you are upgrading and merging with an existing ClearCase site, you install ClearCase from
that site’s networkwide release area and can use that release area’s site defaults for the license
and registry server hosts. More ClearCase licenses may be needed after the upgrade, and you
may have to add them to the license database of the existing license server host.

Plan for Registry Regions
ClearCase LT clients are members of a single region in a ClearCase registry that is maintained on

the ClearCase LT server. The VOB-tags and view-tags in this registry region are unsuitable for
use by ClearCase hosts.
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For a simple upgrade, the upgrade tool cclt2cc registers the VOBs stored on the upgraded
ClearCase LT server host and creates tags for them in the server’s default ClearCase registry
region.

If you need to access these VOBs from client hosts that are not of the same platform type (UNIX
or Windows) as the ClearCase LT server, you must create an additional registry region for use by
these clients, and then create tags appropriate for the hosts that will use this region. Step #6 of
The Simple Upgrade Procedure on page 17 describes this process in more detail.

In the upgrade and merge scenario, you can take advantage of existing registry regions.

Establish Your ClearCase Release Area

Before you begin, verify that you have adequate disk space on an appropriate host platform for
a ClearCase release area. For more information on this topic, see Running the ClearCase Site
Preparation Wizard on page 32.

On Windows platforms, ClearCase LT does not use a networkwide release area.

NOTE: If you are using the upgrade and merge procedure, you do not need to create a new
networkwide release area, because you will use one that already exists.

Remove All ClearCase LT Views

ClearCase LT views must all be removed before you upgrade. These views will not work in a
ClearCase environment and must be recreated after the upgrade. Even if you plan a simple
upgrade in which some ClearCase LT clients are not upgraded right away, all views on these
clients must usually (see note) be removed before the upgrade begins and re-created after the
ClearCase LT server has been upgraded. UCM components, projects, and streams are available
for use when the upgrade is complete. Only the views need to be re-created.

NOTE: If your ClearCase LT server is running UNIX and you plan to use the simple upgrade
procedure to upgrade the server and some, but not all, ClearCase LT clients, you can leave your

ClearCase LT views in place until all the clients have been upgraded.

To remove views:

1. If you are using UCM, complete any deliveries that are in progress.
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2. Check in all checked-out versions of files and directories. Verify that there are no remaining
checkouts by using the ClearCase Explorer or the cleartool Ischeckout command.

3. Remove all views. To do so, we recommend that you use the ClearCase Explorer on any
Windows platform or the cleartool rmview command on either Windows or UNIX.

Issues with Interoperability and Dynamic Views

ClearCase supports two kinds of views:

O Snapshot views, which are also supported on ClearCase LT, copy file and directory
versions from a VOB into the platform’s native file system. Snapshot view users cannot see
changes checked in to the VOB by other users until they update their views.

0 Dynamic views, which are not supported on ClearCase LT, use the ClearCase multiversion
file system (MVFS), which permits users to see changes to files and directories made by other
users as soon as they are checked in to the VOB. ClearCase supports dynamic views on
UNIX and Windows NT computers.

When you use dynamic views in a homogeneous environment (views on UNIX hosts accessing
VOBs on UNIX servers or views on Windows hosts accessing VOBs on Windows NT servers),
the MVFS works with the native network file system (NFS on UNIX, LAN Manager on
Windows NT) and needs no additional support. If your upgraded Windows NT clients will use
dynamic views to access VOBs on UNIX servers, you must install and configure a third-party
software package to support heterogeneous file-system access. Two types of software can
provide support for this type of access:

O An NFS client package that enables a Windows NT client to access a UNIX file system
using the NFS protocol. You install NFS client software on each upgraded ClearCase LT
client that will use dynamic views to access any VOB on a UNIX server.

O An SMB server package that enables a UNIX server to support the LAN Manager SMB
protocol, which is native to all Windows computers. You install SMB server software on the
upgraded ClearCase LT server.

If you plan to install such a package, install it after the upgrade is complete; you can then create
dynamic views—which you will need for testing cross-platform VOB access—on the upgraded

Windows NT client hosts. See Administering ClearCase for more information on this topic.

NOTE: You cannot use a dynamic view to access a VOB on Windows NT from a UNIX computer.
This type of access is supported for snapshot views only.
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3.4 Simple Upgrade

In the simple upgrade procedure, you upgrade a single ClearCase LT community (one server
and some or all of its clients) to ClearCase. Use this procedure if any of the following are true:

O You are not already running ClearCase at your site.

O You are running ClearCase at your site but do not want to make the upgraded ClearCase LT
hosts members of an existing ClearCase registry.

O  You cannot upgrade all of your ClearCase LT client hosts at once and need to preserve VOB
access for both ClearCase LT clients and upgraded clients.

In this procedure, you must upgrade the server first, and then upgrade some or all of the clients.
Many steps in this procedure are also required in the upgrade and merge procedure.

The Simple Upgrade Procedure

To perform a simple upgrade:

1. Prepare. Complete the applicable upgrade prerequisites described in Preparing to Upgrade on
page 13.

2. Create a new networkwide release area. Follow the process described in Running the
ClearCase Site Preparation Wizard on page 32. When you run the Site Preparation Wizard,
specify the name of the ClearCase LT server when you are prompted for the name of the
ClearCase registry host. We recommend, but do not require, that you also configure the
upgraded ClearCase LT server as the ClearCase license server host. If you need to preserve
access to the upgraded server from ClearCase LT clients, you must configure the upgraded
ClearCase LT server as the ClearCase license server host. For more information, see If You
Cannot Upgrade All Your Clients at The Same Time on page 19

3. Remove ClearCase LT software from the ClearCase LT server. Follow the instructions in
Installing Rational ClearCase LT. Do not remove ClearCase LT data unless you are sure you
will not need it after the upgrade. The upgrade procedure preserves all ClearCase LT data
and makes it available to ClearCase after the upgrade is complete.

4. Install ClearCase on the ClearCase LT server. Follow the instructions in Running the
ClearCase Installation Wizard on page 35. Accept the default choices for registry and license
server hosts and for registry region. You will be prompted to create server storage locations
for VOBs and views after the server reboots. The remainder of the upgrade process converts
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existing VOB server storage locations on the upgraded ClearCase LT server, so you only
need to create view storage locations at this time. You may also create additional VOB
storage locations if you wish.

NOTE: When you upgrade the ClearCase LT server, you must install ClearCase in the
directory where ClearCase LT had been installed (normally C:\Program
Files\Rational\ClearCase). Otherwise, the upgrade procedure cannot complete
successfully. This restriction does not apply when upgrading ClearCase LT clients.

Run the upgrade tool. The cclt2cc upgrade tool automates most of the upgrade process. It
performs the following tasks:

O Registers VOB storage locations on the upgraded ClearCase LT server in the server’s
default registry region

0 Creates VOB-tags for VOBs on the upgraded ClearCase LT server in the server’s default
registry region

0 On Windows NT, changes file system protection information on all VOB storage
directories so that it is appropriate for ClearCase

cclt2cc is located in the ccase-home-dir\etc\utils directory. To run cclt2cc:
0 Log in as a user with local administrator privilege to the upgraded ClearCase LT server.

O Run the command in a Windows NT command shell. The example below upgrades all
the VOBs on the ClearCase LT server and creates tags for them in the server’s default
region:

ccase-home-dir\etc\utils\cclt2cc -w tag-registry-password

See cclt2cc Command Line Options on page 23 for complete information on cclt2cc command
line options.

cclt2cc will complete its operations and display any applicable error messages.

Create an additional ClearCase registry region if needed. For more information, see
Creating Additional Regions on page 22.

Install ClearCase on the ClearCase LT clients. Follow the instructions in Running the
ClearCase Installation Wizard on page 35. Accept the default choices for registry region and
license server host.
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8. Create new snapshot and/or dynamic views. Use the ClearCase Explorer or the mkview
command. For information on reusing UCM streams, see Creating New UCM Views Using
Existing Streams.

Creating New UCM Views Using Existing Streams

The upgrade process preserves all of a UCM project’s streams. If your upgrade takes place while
a project is active, you may want to create new views using the project’s existing streams. You
can use either the Project Explorer or the Join Project Wizard to do so:

In the Project Explorer:
1. Select the stream you want to use.

2. Click File>New>View

In the Join Project Wizard:
1. Select the project you want to join
2. In Step 2 (Create a Development Stream), click Advanced Options.

3. On the Stream tab, click Reuse an existing development stream, and then select the stream
you want to reuse.

If You Cannot Upgrade All Your Clients at the Same Time

If you've chosen to do a simple upgrade, you can defer upgrading some of your ClearCase LT
client hosts for a few days or weeks to accommodate development schedules or other
organizational requirements. ClearCase LT client hosts can access VOBs on the upgraded
ClearCase LT server as long as the server is configured as a ClearCase license server host. The
remaining ClearCase LT client hosts need to acquire ClearCase licenses to access VOBs on the
upgraded server, which is possible only if the server itself has been configured as a ClearCase
license server host. These clients cannot be configured to acquire ClearCase licenses from another
ClearCase license server host, even if one is present in your environment. ClearCase LT clients
that operate in this transitional mode are still limited to using the ClearCase LT feature set even
though they require a ClearCase license.
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3.5

Upgrade and Merge

In the upgrade and merge procedure, you upgrade the ClearCase LT server and all its clients at
the same time, then make the server and clients part of a ClearCase registry that already exists at
your site. Use this procedure if all of the following are true:

O

0

O

You are running ClearCase at your site.

You want the upgraded ClearCase LT server and clients to be members of the existing
ClearCase registry.

You can upgrade all ClearCase LT client hosts when you upgrade the server.

CAUTION: Do not use the upgrade and merge procedure unless you can upgrade all ClearCase LT
clients at the same time. Upgrade and merge requires you to make the upgraded ClearCase LT
server part of an existing ClearCase registry region. When you do this, the upgraded server
cannot continue as the registry server for any remaining ClearCase LT clients, and these clients
cannot access VOBs on the upgraded server.

The Upgrade and Merge Procedure

To upgrade and merge your ClearCase LT community:

1.

Prepare. Complete the applicable upgrade prerequisites described in Preparing to Upgrade on
page 13. Make sure that all of your ClearCase LT clients are ready to be upgraded. After you
complete Step #3, no Clearcase LT client can access VOBs or views on the ClearCase LT
server.

Install additional ClearCase licenses on the license server host if needed. Users who run
ClearCase commands on upgraded ClearCase LT hosts can use licenses from the existing
license pool. If you already have an adequate number of these licenses, you do not need to
install additional licenses.

Remove ClearCase LT software from the ClearCase LT server. Follow the instructions in
Installing Rational ClearCase LT. Do not remove ClearCase LT data unless you are sure you
will not need it after the upgrade. The upgrade procedure preserves all ClearCase LT data
and makes it available to ClearCase after the upgrade is complete.

Install ClearCase on the ClearCase LT server. Follow the instructions in Running the
ClearCase Installation Wizard on page 35. Do not create a networkwide release area or run the
Site Preparation Wizard. The upgrade and merge procedure assumes that you are merging
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10.

11.

12.

the ClearCase LT server and clients into a ClearCase installation for which these steps have
already been completed.

With the exception of the registry server host name, you should accept all of the site default
values (license host, view text mode, and so on) as defined. Override the site default value
for registry server host, and instead, specify the ClearCase LT server’s host name as the
registry server.

NOTE: When you upgrade the ClearCase LT server, you must install ClearCase in the
directory where ClearCase LT had been installed (normally

C:\Program Files\Rational\ClearCase). Otherwise, the upgrade procedure cannot
complete successfully. This restriction does not apply when upgrading ClearCase LT clients.

Run the upgrade tool. See Step #5 on page 18.

Get information about storage locations and VOBs on the upgraded server. Log in to the
upgraded ClearCase LT server. Run the cleartool Isstgloc -1 and Isvob -1 commands to get
information about server storage locations and VOBs on the upgraded server. You will use
this information in Step #7 and Step #8 of this procedure.

Register the upgraded server’s storage locations in the existing registry. On another
ClearCase host—one that has network access to the file system of the upgraded ClearCase LT
server and is a member of the registry in which you want VOBs on the upgraded
ClearCase LT server to have tags—run the cleartool mkstgloc command to register storage
locations on the upgraded ClearCase LT server.

Register and create tags for the upgraded server’s VOBs in the existing registry. On the
same ClearCase host that you used in Step #7, run the cleartool register and mktag
commands to register and tag the VOBs on the upgraded ClearCase LT server.

Verify that the VOBs are accessible. Make sure that all ClearCase hosts in the region can
access the VOBs on the upgraded ClearCase LT server.

Make the upgraded server a member of the existing registry. Reconfigure the upgraded
ClearCase LT server so that it is no longer a registry server, and is instead a member of the
existing registry region.

Create an additional region if needed. For more information, see Creating Additional Regions.

Install ClearCase on the ClearCase LT clients. Follow the instructions in Running the
ClearCase Installation Wizard on page 35. Accept the default choices for registry region and
license server host.
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13. Create new snapshot and/or dynamic views as needed for the upgraded clients. Use the
ClearCase Explorer or the mkview command. For information on reusing UCM streams, see
Creating New UCM Views Using Existing Streams on page 19.

3.6

Creating Additional Regions

If you are doing either of the following, you need to create an additional registry region after the
upgrade is complete:

0 Using the simple upgrade procedure to upgrade a ClearCase LT community that includes
both UNIX and Windows computers

0 Using the upgrade and merge procedure to merge a ClearCase LT community that includes
both UNIX and Windows computers into a ClearCase installation that only includes
computers of one type or the other

In Step #4 of The Simple Upgrade Procedure on page 17, you specify that the upgraded

ClearCase LT server will host the ClearCase registry after the upgrade. By doing this, you ensure
that VOB-tags created in the registry’s default region are appropriate for hosts of the same type
as the upgraded ClearCase LT server. Hosts of a different type cannot use these VOB-tags to
access the VOBs, so a peer region must be created and VOB-tags must be imported into it. Use
the following procedure:

1. Create the peer region. Use the ClearCase Administration Console on Windows NT (click
Start>Programs>Rational ClearCase Administration>ClearCase Administration
Console), or use the mkregion command on either Windows NT or UNIX. The example
below creates a new region named NTdev:

cleartool mkregion -tag NTdev -tco “NT peer region”

2. Create VOB-tags in the peer region. After you create a peer region, you must use ClearCase
commands to create VOB-tags in it. If the peer region is a Windows region (created to make
the upgraded VOBs accessible to Windows hosts), we recommend using the Region
Synchronizer to import tags from the default (UNIX) region into the peer region. To run the
Region Synchronizer, click Start>Programs>Rational ClearCase Administration>Region
Synchronizer on any ClearCase host running Windows.

If the peer region is a UNIX region, use the cleartool mktag command. You can also use the
ClearCase Administration Console to create VOB-tags and view-tags in any region.

Administering ClearCase has more information on this topic.
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3.7 cclt2zcc Command Line Options

This section summarizes the command line options for the cclt2cc upgrade tool.

SYNOPSIS

cclt2ec -w tag-registry-password [-v vob-tag-list] [-d destination-region] [-p vob-tag-prefix]

OPTIONS AND ARGUMENTS
TAG REGISTRY PASSWORD. Default: None.

-w tag-registry-password
The registry password for the tag registry in which new VOB-tags will be created.

VOBS TO UPGRADE. Default: Upgrade all VOBs.

—v vob-tag-list
Upgrade only the VOBs in vob-tag-list, a comma-separated list of VOB-tags.

DESTINATION REGION. Default: The server’s default region.

—d destination-region
Create VOB-tags in destination-region instead of the default.

VOB-TAG PREFIX. Default: \vobs.

—p vob-tag-prefix
Create UNIX VOB-tags with a prefix of vob-tag-prefix instead of the default. This option
is ignored if specified on Windows NT.
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Installing ClearCase for Windows
for the First Time

This chapter describes how to install the ClearCase family of products on Windows computers
for the first time.

This chapter assumes that you are a Rational ClearCase administrator who is unfamiliar with the
site-preparation and installation procedures. See Installation Overview on page 26 for an outline
of the procedures.

4.1 ClearCase Default Installation Directory

ClearCase documentation uses ccase-home-dir as shorthand for the ClearCase installation
directory. When you encounter this notation, substitute your own local ClearCase installation
directory for ccase-home-dir.

For new installations, the default installation directory is

system_drive:\Program Files\Rational\ClearCase, where system_drive is the drive that contains
Windows system files. A typical installation directory is

C:\Program Files\Rational\ClearCase.

NOTE: A ClearCase administrator can change the default directory by running the Site
Preparation Wizard.
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4.2

Installation Overview

To install this release of ClearCase:

Ensure that you have met the networkwide site prerequisites Section 4.3
Decide about certain installation considerations Section 4.4
Run the Site Preparation Wizard to prepare release areas Section 4.5
Run the ClearCase Installation Wizard to install ClearCase Section 4.6
Examine ClearCase Doctor results Section 4.7
Run the ClearCase Storage Configuration Wizard (on the server) Section 4.8
Complete the installation Section 4.9
Set up MultiSite synchronization, if you installed MultiSite Section 4.10

Typically, the ClearCase administrator prepares the release area by running the Site Preparation
Wizard and installs ClearCase server software on the server hosts.

Then, users install ClearCase client software on their computers, taking the ClearCase settings
established during site preparation as defaults. In this case, you can start with Section 4.6.

The ClearCase Installation Wizard performs both server and client installations (see Server and
Client Installation Considerations on page 28).

4.3

Meeting Networkwide Site Prerequisites

If you are installing ClearCase at your site for the first time, you must perform the following
preparatory planning and configuration steps:

O Read the ClearCase and MultiSite Release Notes, especially README FIRST.
O Select the ClearCase server host for your network.
O Ensure that you have local or domain administrator privileges.

The remainder of this section discusses the second and third steps.

Select the ClearCase Server Host

Select the computer that will act as your first ClearCase server. By default, this host handles
various ClearCase administrative functions and also holds your ClearCase data. This host can
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function as the license server, the registry server, and the (optional) credentials server. See also
Server and Client Installation Considerations on page 28.

For a new installation, we recommend using one server host for all these functions. Over time,
you will probably want to use multiple hosts for different ClearCase functions. See Administering
ClearCase for information about server configuration.

Maintenance Requirements

Because ClearCase objects (such as VOBs and views) make up your organization’s data
repository, you must back them up regularly. In addition, you must run maintenance programs
on VOBs regularly, to regulate their growth. (See Administering ClearCase for details.)

Windows Server Software and ClearCase Servers

Windows NT and Windows 2000 systems impose a limitation on concurrent access: a maximum
of 10 systems can access a Windows NT or Windows 2000 Workstation system simultaneously
by means of file-system mounts or UNC names.

If you anticipate approaching this level of use, at which many ClearCase users access the same
VOB simultaneously, install Windows NT or Windows 2000 Server software on your primary
ClearCase servers.

In general, views imply a lesser degree of sharing and concurrency than VOBs. In fact, many
views are dedicated to a single user. However, if you devote one or more systems to storing large
numbers of views, then concurrent, view-related access to the view server computers is
significant.

Ensure That You Have Local or Domain Administrator Privileges

ClearCase site preparation requires that you have either local or domain administrator
privileges:

O If the installation is new, you need domain administrator privileges to create the ClearCase
service account and ClearCase group necessary to run ClearCase.

0 Alternatively, if the installation is new and you do not have domain administrator
privileges, your domain administrator can create the account manually before you run the
ClearCase Site Preparation Wizard. You then need only the names of the account and group
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(and the domain in which they were created) and the account password to run the wizard
with local administrator privileges.

See Administering ClearCase for details about the ClearCase service account and ClearCase group
(including how to create them manually).

NOTE: If you have a multidomain environment, see Administering ClearCase for more information
about using Windows NT domains with ClearCase.

4.4

Installation Considerations

Before you run the ClearCase Site Preparation Wizard, you must decide whether you will do any
of the following:

0 Configure the installation computer as a client or as a server and decide which computer is
to be the license server

Install Internet Explorer

Enable remote administration of the computer

Use the latest VOB database format

Install MultiSite (if you are configuring the computer as a server)

Install on a dual-boot computer

O0o0ooao

The following sections provide information to consider in making these decisions.

Server and Client Installation Considerations

When you install ClearCase on a computer, you choose whether to configure that computer as a
server or a client:

O A server is a reliable computer that provides ClearCase resources to other computers on a
local area network.

O A clientis a computer on which a ClearCase user works, typically using one or more views
to operate on ClearCase elements stored in VOBs.

You must designate one server as the license server; you must decide how many ClearCase and

MultiSite licenses you need; and you must decide how to allocate these licenses on your network.
(For details, see Appendix A.)
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In addition, you must designate a registry server, a Windows registry region, and an SMTP
server. The ClearCase scheduler sends e-mail messages using the SMTP server. Optionally, you
designate a credentials server if your site supports ClearCase clients on Windows 98 or
Windows Me, and a UNIX registry region if your site supports Windows/UNIX interoperation.
For more information about these servers, see Administering ClearCase.

As noted in Select the ClearCase Server Host on page 26, you can designate a single computer as
the server that handles all these server functions.

A Windows NT or Windows 2000 computer can be a server or a client. A computer running
Windows 98 or Windows Me can be a client only.

A ClearCase server running Windows NT or Windows 2000 can support the following:

Registered locations where clients can create VOB and view storage directories
ClearCase MultiSite-replicated VOBs and services

A ClearCase registry, license, or credentials server

All capabilities of a Windows NT or Windows 2000 client

Oo0ooo

A ClearCase client running Windows NT or Windows 2000 can support the following:

O Snapshot and dynamic views
0 Local VOBs and views

A ClearCase client running Windows 98 or Windows Me can use snapshot views and have
snapshot view directories. It cannot use dynamic views or be the location of VOB or view storage
directories.

Which features a particular ClearCase computer has depend on both the site defaults

(established by the ClearCase Site Preparation Wizard) and the options chosen if the person
performing the installation overrides the site defaults.

Cross-Platform Consideration
If you have a mixed network environment of Windows and UNIX computers, you can use a

UNIX host as a registry server or as a license server. For more information about
Windows/UNIX interoperation, see Administering ClearCase.
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Internet Explorer Consideration

The ClearCase Explorer, the ClearCase HTML Diff Merge tool, the ClearCase Automation
Library (CAL) documentation, and the ClearCase Administration Console, including its help,
require Internet Explorer Version 4.01 Service Pack 1 (SP1) or later to function correctly.
Moreover, the Microsoft Management Console (which is used by the ClearCase Administration
Console) may not install correctly without Internet Explorer Version 4.01 SP1.

You can download and install Internet Explorer from the Microsoft Web site:
www.microsoft.com/windows/IE

See also Remote Administration Considerations.

Remote Administration Considerations

If you enable ClearCase Remote Administration, any user who is both logged on to another host
and a member of the ClearCase service group can use the Administration Console to change
ClearCase properties for clients and servers. These ClearCase properties can be changed:

O Registry regions

O License server

O Registry and backup registry servers

O MVES cache sizes

Remote administration capability is useful if, for example, you move your license server to a new
host. You can then change the settings for all clients from a single computer.

If you do not enable Remote Administration, only the local user can change that computer’s
ClearCase properties.

Remote administration requires Internet Explorer Version 4.01 or later to function properly. See
the previous section, Internet Explorer Consideration, for more information.

For more information, see Administering ClearCase.
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VOB Database Format Considerations

The current ClearCase release supports two VOB database formats. For VOB server installations,
you must select one of the following:

0 The latest VOB database format
New installations should select this format. (It is the default.)
O The VOB database format that is compatible with release 3.2.1

In most cases, only existing installations should select this format.

If you have an existing ClearCase installation, you can run -ver from the cleartool command line
to see the current vob database schema version. For more information, see VOB Database Support
on page 6 and the ClearCase and MultiSite Release Notes.

MultiSite Installation Considerations
You can install MultiSite only on ClearCase server hosts.

MultiSite need not be installed on all ClearCase computers. In most cases, only the following
computers require MultiSite installation:

0 Computers on which one or more replicated VOBs reside.

0 Computers that belong to users with ClearCase and MultiSite administration
responsibilities.

O Computers on which the shipping_server utility will be used, even if no replicated VOBs
will reside on that computer. Running shipping_server does not require a MultiSite license.
For more information about this utility, see ClearCase MultiSite Manual.

Installing ClearCase on Dual-Boot Computers

On a computer that can boot multiple Windows NT, Windows 98, Windows Me, or Windows
2000 installations, do not install ClearCase in the same directory for any two installations.
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If you install to the same directory, various identical ClearCase components are shared.
Removing ClearCase from that directory disables ClearCase for every version of Windows that
uses the common directory. Furthermore, when a common directory is used, it is not possible to
install different ClearCase releases for each version of Windows.

To avoid these problems, install ClearCase in distinct directories for each version of the operating
system. If you have encountered this problem already, the workaround is to reinstall ClearCase.

4.5

Running the ClearCase Site Preparation Wizard

Typically, the ClearCase administrator runs the Site Preparation Wizard (a program called
siteprep) to create and configure a single release area for the site. At ClearCase releases 4.2 and
later, you can specify more than one set of site defaults per release area. For information about
creating multiple site default files, see Creating Multiple Site Default Files for a Release Area on
page 34.

If you designated a single computer as the ClearCase server (see Select the ClearCase Server Host
on page 26), run the Site Preparation Wizard on that computer.

As the administrator, run the ClearCase Site Preparation Wizard as follows:

1. Logon to the server computer as a user with either local or domain administrator privileges.
(The section Ensure That You Have Local or Domain Administrator Privileges on page 27
describes how to determine which is required.)

2. Place the ClearCase CD in a drive accessible from the ClearCase server. The ClearCase Site
Preparation Wizard starts automatically.

The wizard asks whether to run ClearCase site preparation or to do an evaluation
installation. Click Start the Site Preparation Step of ClearCase Installation. (For details
about the evaluation installation, see Chapter 5.)

3. Follow the instructions as they appear.

O At the beginning of ClearCase Site Preparation, ClearCase Doctor checks the
configuration of your computer. If ClearCase Doctor finds problems, it provides detailed
instructions for correcting them and often offers to fix problems for you.

O The steps instruct you to specify site-wide default values, which are used in prompts by
the ClearCase Installation Wizard. Most steps contain Help buttons, which provide
detailed information to assist you in making your choices.
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O You also are asked whether you intend to install MultiSite optional software. (See
MultiSite Installation Considerations on page 31.)

O The Attache helper software is installed when the multiversion file system (MVES) is
installed.

0 If you are installing ClearCase on a nondomain system, select None on the ClearCase
Service Account screen. A message informs you that you can use ClearCase data only on
this system. To access data on a UNIX system, you must override the registry and license
servers and the interoperability region values after you complete the installation by
using the ClearCase Control Panel.

NOTE: As a rule, nondomain system installations are not recommended. For more
information about using ClearCase on nondomain systems, see Administering ClearCase.

After you specify these values, the wizard asks whether to save new site preparation defaults
or to create new network release area. Click Create new network release area. The wizard
creates an on-disk image of the ClearCase CD that serves as the ClearCase release area in a
directory on the server. It also creates a first site default file. By default, this file is named
sitedefs.dat. You can change it to a meaningful name.

4. You are now prompted to start the ClearCase Installation Wizard. Proceed to install
ClearCase on this server using the newly created release area.

For details about running the ClearCase Installation Wizard, see Installation Considerations on
page 28 and Running the ClearCase Installation Wizard on page 35.

5. Make the release area directory shareable. Even if the drive containing that directory is
already shareable, making the directory itself shareable makes it easier to find the ClearCase
release area.

a. In Windows Explorer, right-click the network release area to display the directory
shortcut menu.

b. Click Sharing. The Properties dialog box appears.

C. On the Sharing tab, click Shared As and supply a meaningful share name, such as
CCNT4.2 Release Area.
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Creating Multiple Site Default Files for a Release Area

Many sites handle only one set of ClearCase users. But some sites require different sets of users
to work with different default settings. For example, a development group and a quality
engineering group may use different Start menu commands or different registry servers. In this
case, you can create one site default file for each group.

To create multiple site default files for a release area:

1.

Create the initial release area by following the instructions in Running the ClearCase Site
Preparation Wizard on page 32. Set up this area with the site-specific parameters relevant to
the first group of users.

Rerun the ClearCase Site Preparation Wizard from the release area that you created in
Step #1. In this case, do not run the wizard from the CD. Instead, double-click siteprep in the
release area or run siteprep.exe on the command line.

Follow the instructions to set the ClearCase parameters. Because you have created a first site
default file (sitedefs.dat for instance), in the initial release area, the Site Preparation Wizard
displays the values set in sitedefs.dat. Keep the values that apply to both groups and change
the ones according to the needs of the second group.

When you come to the Save Site Defaults step, click Save new site preparation defaults in
existing release area.

You are now prompted to enter a name for the new site defaults file.

0 If you started the site preparation on the command line and specified a file-name
argument for this new site defaults file, for example, sitedefs.developers, the field
displays this name.

0 If no file name was previously specified, the field is blank. Type a name that does not
currently exist in the release area.

NOTE: If you enter the name of an existing file, a warning message appears. You can
overwrite the existing file or specify a different name to create a new file.

According to your needs, you may create many more subsequent site defaults files in this way.
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Creating Multiple Release Areas

Because ClearCase releases 4.2 and later support multiple site defaults per release area, creating
multiple release areas become unnecessary but remains an alternative.

To create a second release area:

1. Create the initial release area by following the instructions in Running the ClearCase Site
Preparation Wizard on page 32. Set up this area with the site-specific parameters relevant to
the first group of users.

2. Rerun the ClearCase Site Preparation Wizard from the release area you created in Step #1. In
this case, do not run the wizard from the CD. Instead, double-click siteprep in the release
area.

When you create the second release area by running the ClearCase Site Preparation Wizard
from the first release area, the second release area is created using the site-specific parameters
from the first release area instead of the initial settings from the CD, which you may have
overridden when you created the first release area.

3. When you come to the Save Site Defaults step, click Create new network release area.

NOTE: If you run the ClearCase Site Preparation Wizard on a computer that has ClearCase
installed, the installed values on that computer override the release area defaults.

4.6 Running the ClearCase Installation Wizard

The ClearCase Installation Wizard installs ClearCase and optionally MultiSite, if it was specified
as defaults during site preparation. Attache helper is installed if the multiversion file system
(MVES) is installed.

If you are installing ClearCase on a client computer from a release area designated by your
ClearCase administrator, Step #1 of the following procedure is not relevant. In most cases, take
the defaults as presented on the installation screens. See your ClearCase administrator for more
information.

If you are a ClearCase administrator and choose to run the ClearCase Installation Wizard after
the Site Preparation Wizard runs, Step #2 and Step #3 of the following procedure are not relevant.
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Review Installation Considerations on page 28.
Log on as a user with local administrator privileges.

To install ClearCase using a specific set of site defaults, run setup.exe on the command line
and specify the name of the site defaults file. For example:

setup.exe sitedefs.developers

If you want to install ClearCase using the default site defaults file (sitedefs.dat), do one of
the following;:

O On the command line, run setup.exe and don’t specify a file name.

0 In Windows Explorer, navigate to the ClearCase network release area. Double-click the
setup icon.

Follow the instructions as they appear. Most panels contain Help buttons to access
information about the parameters or questions in the panels.

O At the beginning of the installation, the wizard reads the site defaults specified during
site preparation. ClearCase Doctor then checks the configuration of your computer. If
ClearCase Doctor finds problems, it provides detailed instructions for correcting them
and often offers to fix problems for you.

0 If your computer is running Windows NT or Windows 2000, you have the option of
configuring it as a ClearCase client or server. Typically, ClearCase users should configure
their computers as ClearCase clients. See Server and Client Installation Considerations on
page 28 for details about what ClearCase functionality is supported on clients and
servers, or consult your ClearCase administrator.

O Site-specific defaults have been defined for most steps in the ClearCase Installation
Wizard. Consult your ClearCase administrator before overriding these defaults.

0 If this computer has been designated as the ClearCase license server, you are prompted
to enter the ClearCase license keys. If you already have your ClearCase license keys,
enter them when prompted.

If you do not yet have your license keys, click Next. In this case, obtain and enter the
license keys after the installation, using the procedures described in License Server
Postinstallation Procedure on page 39.

NOTE: Although you can install ClearCase, users at your site cannot run ClearCase until
the license information is supplied.
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O The Start Copying Files panel lists all the components to install. You can either accept
the list to proceed with the installation or go back to change previous answers.

5. Attheend of the installation, you are prompted to restart the computer. After you restart the
computer, ClearCase Doctor checks the new configuration of your computer. See Examining
ClearCase Doctor Results on page 37.

6. If youareinstalling on a ClearCase server and have specified that locations on the server will
be available to clients for VOB and view storage directories, you must specify those
locations. See Running the ClearCase Server Storage Configuration Wizard on page 38.

7. Follow the instructions in Completing the Installation on page 38.

ClearCase Administrator Notes

If you overrode the defaults for the ClearCase license, registry, or credentials servers, you must
install ClearCase on these computers next. Because ClearCase clients use storage on ClearCase
servers to create view and VOB storage directories, install ClearCase on those servers before you
install ClearCase on clients.

Because you have created a network release area and provided default answers to most of the
questions the ClearCase Installation Wizard asks, individual users can use your defaults to
install ClearCase on their computers.

Note, however, that users can override any defaults that the ClearCase Site Preparation Wizard
established when they run the ClearCase Installation Wizard on their computers.

It is possible to install ClearCase on individual computers directly from the CD, but it is not
recommended. Each person who installs ClearCase directly from the CD must research and
supply answers to many questions. If you decide to install ClearCase directly from the CD, you
also must have the password for the ClearCase service user account.

4.7 Examining ClearCase Doctor Results

ClearCase Doctor is run by the ClearCase Installation Wizard before installing a new version of
ClearCase, and also runs on a new installation after you log on. Thereafter, you can set ClearCase
Doctor to run each time you log on (the default), turn it off entirely, or run it in the background.
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At a minimum, we recommend that you run ClearCase Doctor in the background so that it can
detect changes in your ClearCase environment that may affect operations.

ClearCase Doctor checks basic configuration information for a site or an individual computer. If
it finds a problem, it suggests a solution and often offers to fix the problem for you.

In addition to checking configuration information, ClearCase Doctor displays configuration
information. To display all configuration information messages, click Options>Verbose in
ClearCase Doctor.

You can run ClearCase Doctor at any time. Click Start>Programs>ClearCase
Administration>ClearCase Doctor.

4.8

Running the ClearCase Server Storage Configuration Wizard

If you specified that your computer is to be a ClearCase server and that locations on that server
are to be available to ClearCase clients for creating VOB and view storage directories, the
ClearCase Server Storage Configuration Wizard runs when you first log on after the installation
restart.

NOTE: You must log on as the same user who ran the installation.

This wizard allows you to specify locations on the server that will be available to ClearCase
clients for VOB and view storage directories.

The online help for the wizard provides detailed configuration information.

You can configure the locations by using the wizard now or wait until the next logon. On the next
logon, you can configure the locations from the ClearCase Registry snap-in of the ClearCase
Administration Console. You can also run ccase-home-dir\etc\SvrStor.exe or the mkstgloc
command from the cleartool command line. For more information about storage configuration,
see Administering ClearCase.

4.9

Completing the Installation

After running the ClearCase Installation Wizard, follow the steps in this section to complete the
installation process.
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License Server Postinstallation Procedure

If you specified that your computer is to be a ClearCase license server and did not enter the
license key information during installation, you must enter the appropriate ClearCase license
keys (sometimes called license authorization codes) before you can use ClearCase. See also
Allocating ClearCase Product Family Licenses on page 47.

When you have the license keys, enter them using the following procedure:
1. On the ClearCase license server, run the ClearCase Control Panel program.
2. On the Services Startup tab:
a. Click Shutdown ClearCase.
b. Click Yes, and then click OK.
3. On the Licensing tab:
a. Click The local system can act as a license server.
b. Enter your ClearCase and MultiSite license keys.

NOTE: License keys must be entered exactly as specified (for example, uppercase and
lowercase letters must be preserved.)

c. Click OK.
4. On the Services Startup tab, click Startup ClearCase.
See also the clearlicense and license.db reference pages in the ClearCase Reference Manual.

5. If this is the first time you have used this computer as a license server, you must reboot the
computer before you can use ClearCase on it. If you have previously used this computer as
a license server, you need not reboot.

Administrator Postinstallation Procedure (NTFS)
If you install ClearCase on an NTFS file system, the ClearCase service account must have
read /execute permissions for the ccase-home-dir directory. The local administrator must perform

the following steps after ClearCase is installed.

1. Log on as the local administrator.
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In Windows Explorer, navigate to the ClearCase installation directory, and right-click that
directory.

Click Properties. A property sheet for the directory appears.

On the Security tab, click Permissions and modify the permissions to add Read and Execute
(RX) rights for the ClearCase service group. Do not change any other rights for any group or
user.

NOTE: Be careful when modifying file-system permissions. Adding or removing rights can
compromise file-system security or even render the computer inoperable.

Per-User Postinstallation Procedure

Each ClearCase user who logs on and works on the ClearCase client or server must perform this

procedure:

1. Log on using your normal user account (not as the local administrator).

2. When prompted by ClearCase Doctor, click Start Analysis to do an initial analysis.

NOTE: ClearCase access control relies on coordinated group assignments.

3. On the Topics tab, double-click the User Logon Account folder in the tree view.

4. If your primary group is incorrect, ClearCase Doctor reports the problem and provides
instructions to correct it. You may need to set the CLEARCASE_PRIMARY_GROUP environment
variable.

5. UNIX and Windows NT (or Windows 2000) mixed environment users only — After your

primary group is set, verify that it matches your UNIX primary group using the following
command:

ccase-home-dir\etc\utils\credmap UNIX-hostname

For more information, see Administering ClearCase.

4.10 Setting Up MultiSite Synchronization

Each site that uses Rational ClearCase MultiSite stores configuration settings locally. You can
modify these settings at any time after installing MultiSite, using either of the following:
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0 MultiSite Control Panel

Configures MultiSite’s store-and-forward facility, which delivers synchronization packets
between sites. See the MultiSite Control Panel reference page. To see the online help, click

Start>Programs>ClearCase Administration>MultiSite Help.
0 Synchronization scripts

After installing MultiSite, you can automate replica synchronization by editing MultiSite
configuration files and scheduling regular execution of synchronization scripts. For more
information, see the ClearCase MultiSite Manual.
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Installing ClearCase Release for
Evaluation

You can perform an evaluation installation to interact with Rational ClearCase without having
to perform all the steps necessary to set up a full-fledged ClearCase site. The evaluation
installation allows you to run the ClearCase tutorial and to try most ClearCase functions.

NOTE: You cannot perform an evaluation installation over a previous ClearCase installation.

5.1 Evaluation Installation Is Not Supported on Windows 98 or
Windows Me
You cannot perform an evaluation installation on Windows 98 or Windows Me because these
operating systems do not support the creation of local VOB and view server processes.

5.2 Performing an Evaluation Installation

Install the ClearCase evaluation copy directly from the CD. (Standard licensed installations are
performed from a network release area.) The evaluation installation is not intended for
production work or any permanent use, nor is it supported for any production work or
permanent use.

To perform an evaluation installation:
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1. Logonas thelocal administrator on the evaluation computer (that is, the computer on which
you want to evaluate ClearCase).

2. Insert the ClearCase CD in the drive on the evaluation computer.
3. Click Do an Evaluation Installation of ClearCase to this workstation.

4. Follow the instructions as they appear on the screen.

The evaluation computer is configured as a stand-alone ClearCase site. All accounts and services
created are local to the evaluation computer. Anyone who logs on to the evaluation computer is
prompted to start the ClearCase tutorial.

5.3

What the Evaluation Installation Does

The evaluation installation creates a ClearCase service account (clearcase_albd) and a ClearCase
service group (clearcase), both local to the evaluation computer. These local accounts are
removed by running uninstal or by upgrading to a licensed installation.

In the ClearCase configuration for the evaluation installation, the evaluation computer serves as
both license and registry server. These servers have a default region of evaluation_region and
local service account and service account group of

0 .\clearcase_albd
O .\clearcase

In this notation, .\ is shorthand for a Windows NT or a Windows 2000 domain local to the
evaluation computer.

5.4

Completing the Evaluation

After you finish evaluating ClearCase, you can remove it by running the following program from
the CD:

cd_drive:\cpf\nt_i386 \uninstal.exe
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You can also remove the ClearCase evaluation installation by performing a standard product
installation. If you choose to upgrade your evaluation installation to a licensed installation, all
the temporary accounts local to this workstation are removed also.

NOTE: The ClearCase evaluation installation creates a shared directory on the evaluation
computer. Uninstalling the evaluation does not remove this shared directory or any storage areas
you create while evaluating ClearCase. You must remove these areas manually.

5.5

Limitations of the Evaluation Copy of ClearCase

An evaluation installation is for only a single user. You cannot share configuration management
data with other users. Nothing you do in the evaluation installation can be carried over to the
standard product installation. All VOBs and views you create using the evaluation installation,
and the source code entered into them, are transitory. You can delete these VOBs and views when
the standard licensed product installation is performed. Any source code you create using the
evaluation installation must be reentered when you install the full ClearCase product. Also, the
service accounts and groups created under the evaluation installation are transitory and local to
the computer on which you installed the evaluation copy.

The evaluation configuration allows users logged on to this computer to create versioned object
bases (VOBs) and ClearCase views. These VOBs and views cannot be preserved past their use in
the evaluation installation. If you upgrade to a fully licensed installation of ClearCase, you must
reimport the sources into ClearCase. These restrictions make the simple evaluation installation
possible.

For this installation, the evaluation computer is configured for a one-month license, starting from
the date of the initial evaluation installation. Even if you remove ClearCase and then reinstall an
evaluation copy, the period is one month from the initial installation. If you want to extend the
evaluation period, contact your Rational sales representative.
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Allocating ClearCase Product
Family Licenses

Rational ClearCase and Rational ClearCase MultiSite implement an active-user floating license
scheme. Details of how this scheme controls a user’s access to ClearCase and MultiSite are
available in the clearlicense and license.db reference pages (see the ClearCase Reference Manual).

This appendix provides an overview of licensing and considerations for allocating licenses.
Instructions for enabling ClearCase and MultiSite licenses are in License Server Postinstallation
Procedure on page 39.

After you determine your license allocation, you must fill in the appropriate number of License
Registration Forms and submit them according to the instructions on the form. A copy of the
License Registration Form appears at the back of this manual. You will receive your license keys
by return fax as soon as possible.

The set of licenses is maintained on the license server. The network can have one license server,
or several. Each license server runs a ClearCase server process, and so must have ClearCase
installed.

NOTE: ClearCase and MultiSite use the same license server—the computer displayed on the

Licensing tab in the ClearCase Control Panel program. To open the ClearCase Control Panel
program, double-click ClearCase in Windows Control Panel.
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Allocating ClearCase Licenses

Suppose that your organization has purchased 25 ClearCase licenses. It’s up to you to decide
how many license servers to use and how to allocate licenses to them. Here are two examples:

O

Use a single license server. In this case, request a single license authorization code for 25
licenses. Create a single license database incorporating this code.

A drawback of this strategy is its single point of failure. If your network’s lone license server
fails, no one is able to use ClearCase. In this scenario, consider making an important
ClearCase data server act as the license server also; if that server fails, important data is
unavailable, so the incremental inconvenience of not being able to use ClearCase is small.

Use two license servers. In this case, request two license authorization codes, perhaps one
for 15 licenses and another for 10 licenses. Create two license databases incorporating these
codes, on two different servers.

This strategy provides for more robustness. If the 15-license server fails, developers can still
use ClearCase. Using ClearCase Host Administration, the administrator can find the
properties of each affected host and reset the license server. See Administering ClearCase.

A.2

Allocating MultiSite Licenses

Each user of a replicated VOB must acquire both a ClearCase license and a MultiSite or Attache
MultiSite license; moreover, the two licenses must be acquired from the same license server host.
Therefore, plan your MultiSite licenses by analyzing each current ClearCase license server:

O

If some or all of the clients that use a particular license server will access replicated VOBs,
you must install MultiSite licenses on that license server.

If all users on those clients will access replicated VOBs, it makes sense to install the same
number of MultiSite licenses as ClearCase licenses.

If some users will access standard (unreplicated) VOBs only, you do not need MultiSite
licenses for these users.

For example, a company has two sites, with 20 developers at site A and 5 developers at site B.
The company has three VOBs at site A; two of them will be replicated to site B and one will not
be replicated. Five of the developers at site A will access only the unreplicated VOB, and the
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remaining 15 will work in all VOBs. Therefore, the company needs to purchase the following
numbers of licenses:

Site Number of ClearCase licenses Number of MultiSite licenses
A 20 15
B 5 5

NOTE: This example assumes that you purchase a ClearCase license for each developer. If you
have fewer ClearCase licenses than developers, you can purchase a proportionate number of
MultiSite licenses. For example, if site B purchased three ClearCase licenses, it would also

purchase three MultiSite licenses.
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ClearCase Product Family License Registration Form

The ClearCase family of products includes a license enforcement mechanism. As described in the
product’s installation documentation, you must obtain a license authorization code, an encoded line of text to
be inserted into a special license database file. Please fill in the following form completely. Upon completing
the form, FAX it to Rational Software Corporation at (781) 676-2460. You will receive your authorization
code via return FAX as soon as possible.

ClearCase Family Product to License (check one):
[ ] ClearCase [ ] MultiSite [ ] ClearTrack

[ ] ClearCase Attache [ | Attache MultiSite

Your Company

Company name
Address
City/State/Country/Postal Code
Contact Person

Phone number (with area code):
FAX number (with area code):
Electronic mail address of contact person:

chensmg Information

NG RN e

8. Purchase Order Number (For new licenses purchased):
9. License server host ID:
If ClearCase is installed, enter clearlicense —hostid on the license server. If not:

SunQOS 4: run /bin/hostid to determine 8-digit hex number

Solaris: run /usr/sbin/sysdef —h to determine 8-digit hex number

HP-UX: run /binfuname —i to determine number (usually, 10 or 12 digits)

AIX: run /bin/uname —m to determine 12-digit number

IRIX: run /etc/sysinfo; use first four pairs of hex digits from first line

Compaq Tru64 UNIX  use last four pairs of hex digits of “Ethernet Interface, hardware

or Digital UNIX: address” in /var/adm/messages

UnixWare: install ClearCase and enter command clearlicense —hostid

Windows NT: on the command line, cd to cpf\nt_i386 on ClearCase CD-ROM,; run hostid

MP-RAS run ildconfig; use 12-digit number displayed in NODE field for first
csma/cd adapter

Reliant UNIX run /usr/ucb/hostid

10. New licenses requested or additional licenses required:
Number of licenses:

(Do not include licenses already installed. For additional licenses, add new License Authorization Code to
the .db file.)

Please FAX — do not phone and do not use electronic mail






Request to MOVE ClearCase Product Family Licenses

Please complete and sign the following form. Upon completion, FAX to Rational Software Corporation at
(781) 676-2460.

I certify that Rational’s ClearCase software, under the terms of the signed Software License Agreement,
will be deleted in its entirety from the old host referenced below, and will be installed on one or more new
hosts.

Authorized Signature:

Move Licenses (check one):
[ ] ClearCase [ ] MultiSite [ ] ClearTrack

[ ] ClearCase Attache [ | Attache MultiSite

Your Company

1. Company name

2. Address

3. City/State/Country/Postal Code

4. Contact Person

5. Phone number (with area code):

6. FAX number (with area code):

7. Electronic mail address of contact person:

Licensing Information

8. Host ID of old license server: # of licenses

Host ID of new license server #1: # of licenses
Host ID of new license server #2: # of licenses
If ClearCase is installed, run clearlicense —hostid on the license server; if not:
SunOS 4: run /bin/hostid to determine 8-digit hex number
Solaris: run /usr/sbin/sysdef —h to determine 8-digit hex number
HP-UX: run /binfuname -i to determine number (usually, 10 or 12 digits)
AIX: run /binfuname -m to determine 12-digit number
IRIX: run /etc/sysinfo; use first four pairs of hex digits from first line
Compag Tru64 UNIX  use last four pairs of hex digits of “Ethernet Interface, hardware
or Digital UNIX: address” in /var/adm/messages
UnixWare: install ClearCase and enter command clearlicense —hostid
Windows NT: on the command line, cd to cpf\nt_i386 on ClearCase CD-ROM,; run hostid
MP-RAS: run ildconfig; use 12-digit number displayed in NODE field for first
csma/cd adapter

Reliant UNIX run /usr/ucb/hostid

Please FAX — do not phone and do not use electronic mail
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